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Introduction 
When an employee receives a life insurance benefit such as group term life insurance, the possibility exists that 

the employee will be taxed as a result. A certain portion of the benefit is considered “imputed income” and the 

recipient is taxed as if the benefit were taxable income. The amount considered imputed income can vary, as 

can the tax rate and the threshold amount which is exempt. The Life Insurance Tax calculator is a tool that 

allows the user to setup and configure the product to:  

 determine the employer cost of providing the benefit amount to the employee, 

 split the amount between the taxable and exempt benefit and 

 update the employee benefit maintenance records for taxable and exempt benefits for use in payroll. 

 setup different LIT code records to handle multiple scenarios (see scenarios section), 

 integrate with Microsoft Dynamics GP Human Resources 

Process 
Once the setup information has been configured and saved the user either: 

 selects “Update” on the Life Insurance Tax Code Setup window or 

 if the LIT Code is marked to auto update, then processes payroll. 

The system then determines which employees are to have their maintenance records adjusted. The system 

then proceeds to calculate the benefit amount for the employees. This can be done in different ways 

depending on the life insurance tax calculator setups. The process is as follows: 

1. First compensation on which coverage is based must be determined. This is either done by marking the 

Use Primary Pay Code for Coverage checkbox or by specifying a value in the Pay Code for Coverage 

Calculation field. The system uses this information to determine pay/compensation amount. 

2. Secondly, the system determines the total coverage amount and further defines the coverage amount 

per pay period. This is either done by marking the Use HR Premiums & Increments checkbox or 

specifying values in each of the Company Premium Rate – Pay Period, Premium Increment and Factor 

fields. The system uses this information to determine how the coverage will be divided between the 

taxable and exempt benefits. 

3. Thirdly, the system separates the premium for coverage amount per pay period into taxable and 

exempt amounts. It does this by first determining the taxable cost to the employee using the Life 

Insurance IRS table, total coverage amount, payroll frequency, and benefit excess minimum. The 

resulting calculation yields the taxable benefit amount (piece of the premium that is taxable). 

4. Lastly the system updates the employee benefit maintenance records for the taxable and exempt 

benefits.  

5.  The system can then calculate payroll as normal and the correct taxes will be reflected. 
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Quick Setup Steps 
 Define an LIT Code which contains the configuration settings. 

 Set the filter criteria to apply to the appropriate employees to include in the calculation for the LIT 

Code. 

 Determine which method will be used to define the compensation on which coverage is based: 

o Primary Pay Code 

 Mark the Use Primary Pay Code for Coverage 

o Custom Defined 

 Specify values for Pay Code for Coverage Calculation and Payroll Frequency 

 Determine which method will be used to derive premium calculations: 

o Integration with HR 

 Mark the Use HR Premiums and Increments 

o Custom Calculation 

 Specify values for Company Premium Rate – Pay Period, Premium Increment, and Factor 

 Define the Excess Benefit Minimum amount. This is used to determine whether the Life Insurance Tax 

calculator needs to run for a specific scenario or not.  

 Define Taxable Benefit ID and Exempt Benefit ID fields. The Exempt Benefit ID field is uses to 

determine total cost of coverage. 
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Installation Overview  
This section discusses the prerequisites; lists the files installed and go through the install process.  

Prerequisite 
The prerequisite for Life Insurance Tax Calculator is: 

 Microsoft Dynamics GP Payroll 

 Microsoft Dynamics GP Human Resources **optional** 

Files Installed  

The following files are installed: 

GP Folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft 

Dynamics\GP2016) 

 GTLI6833.cnk or GTLI6833.dic 

 Application.IntegrityDataActivation.dll  

 Integrity.Registration.Constructor.dll  

 Integrity.Registration.Addin.dll 

 IDA6537.cnk  

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or 

(C:\Program Files\Microsoft Dynamics\GP2016\Documentation) 

 Life Insurance Tax Calculator User Guide.pdf 

Install Notes 

Prior to installing complete these steps: 

 Confirm all users are logged out of Microsoft Dynamics GP 

 Complete all payroll runs and validate no payroll runs are in process 

 Make a backup of the company and dynamics databases 

Server/Client 

To install Life Insurance Tax Calculator downloaded the exe file from our website.  Once the files have been 

downloaded, you can run them on the Server and/or Client Installations.   The product will need to be installed 

on all machines that process payroll.  If you will send with using Microsoft Outlook then download the Outlook 

Setup.exe in addition to the Integrity GP 2015 or 2016 Setup.exe 

 

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL Server® 

Components.  Creating the Microsoft SQL Server Components needs to be performed on a single computer, 

typically the server. 

http://www.integrity-data.com/hrp/product-download-form/0310360942-2/
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1. Right click Integrity Data GP2015 or 2106 Setup.exe file and select “Run as Administrator”.  If you do 

not see this option, hold the shift key down and right click. 

Complete the steps in the wizard
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2. Verify the GP directory is correct if it is not select Change 

 

3. Select Custom to choose to install only the specific products you purchased.   
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4. Select Activation Components to only install activation manager files.  This option will not install 

products and it is typically run only to fix an error with activation manager. 

5. Select All Components to install all Integrity Data products.  The products you did not purchase will 

register with a 30-day trial period.   

 

If you are upgrading you will be prompted to uninstall the older version, select “y”. If you have multiple 

products, it will uninstall all products. 

 

6. Select the product(s) to install, if installing multiple products, select all that need to be installed. 
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7. Launch Microsoft Dynamics GP 2015 or 2016. 

8. If prompted to include new code, choose yes. 

9. Login as the ‘system administrator’ for each company to create the SQL Server components. 

10. The system will auto activate the products you have purchased if you have access to the internet on 

the machine.  If you receive a message Activation Manager failed contact support@integrity-data.com 

and include a screenshot of the Activation Manager window to receive manual keys. 

  

BEST PRACTICES 

Install is not a requirement 
on the Server; however it is 

recommended. 

Install updated version on 
previously installed Client 

machines. 
 

 

mailto:support@integrity-data.com
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Manual Install 

If the user encounters errors during the installation, complete the following steps to manually install Life 

Insurance Tax Calculator: 

1. Contact support@integrity-data.com to receive the manual install files for the product(s). 

2. Copy and paste the following files into the appropriate locations.  

GP Folder (C:\Program Files\Microsoft Dynamics\GP) 

 GTLI6833.cnk  

 IDA6537.cnk 

 Application.IntegrityDataActivation.dll 

 Integrity.Registration.Constructor.dll 

 Integrity.Registration.Addin.dll 

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP\Documentation) 

 Life Insurance Tax Calculator User Guide.pdf (C:\Program Files\Microsoft 

Dynamics\GP\Documentation) 

3. Edit the Dynamics.exe.config 

 Navigate to the GP folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program 

Files\Microsoft Dynamics\GP2016) 

 Backup the Dynamics.exe.config by making a copy and saving the copy **Important** 

 Open Dynamics.exe.config in Notepad 

 Find the <addin> and under <Dynamics> copy and paste the following: 

<addin name="IDKeyManagerAddIn" 

type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.202

97,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/> 

 Under <DynamicsGPweb> copy and paste the following: 

<addin name="IDKeyManagerAddIn" 

type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.202

97,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/> 

mailto:support@integrity-data.com
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4. Launch Microsoft Dynamics GP. 

5. Login as the ‘system administrator’ for each company to create the SQL Server components. 
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Registration 
The system automatically activates the product during the log in process. If the activation was successful, the 

user will not receive any messages. However, if the activation process was unsuccessful the user will receive a 

message. If the activation process fails the user needs to open the Activation Manager window to activation 

the product. 

Activation Manager Window 
To open the Activation Manager window, within the Navigation Pane select Administration. In the Content 

Pane, select Setup. Under the heading System, click Activation Manager. 

 

Microsoft Dynamics GP > Tools > Setup > System Activation Manager 

The Site Name defaults from the session information on the About Microsoft Dynamics GP window. 

From the Product drop-down list the user may select the product they wish to activate and review product 

information. Once the product is selected the following fields display: 

 Installed Version – Current version number installed 

 Trial Expiration Date – Date of the trial expiration period typically 15 days, if applicable 

 Activation Status – Current status of the product 

o Permanent –Product has been purchased 
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o Trial – Product has been issued a trial period 

o Deactivated – Product has been deactivated 

 Current Employees – This count defaults from the session information on the About Microsoft 

Dynamics GP window. The count does not include inactive employees or employees in a Test or 

Historical company. If the current employee count is incorrect validate Test or Historical companies 

are named correctly.  

 Employees Allowed – The number of employees allowed before the product will be inactivated. If the 

Current Employees exceeds the Employees Allowed the system will deactivate the product.  

The scrolling window contains a list of all companies; by default the product is active for all companies. If the 

user would like to inactivate a company unmark the company checkbox.  

The Auto Activation option may be selected if the user receives a message at log in stating the product is not 

activated. When the user selects the Auto Activation option the system will attempt to automatically activate 

the product. Once the Auto Activation process is complete the system will display the Activation Messages. For 

a detailed list of activation messages see the Activation Manager Messages section. 

The Manual Activation option is used to manually enter a Token. The user would only manually enter a token if 

they were sent a token by Integrity Data. 

Select the OK button to close the window.  

Test and/or Historical Companies 

Registration will not count the active employees in Test or Historical company databases if the Company 

Name is named correctly, specifically at the end of the Company Name the user must append the following: 

“<TEST>” or “<HISTORICAL>”. See examples below: 

 Dextordinary, Inc. <TEST> 

 Dextordinary, Inc. <HISTORICAL> 

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > 

Tools > Setup > Company > Company when logged into the Test or Historical Company that needs modified. 

Version Information 

To obtain the latest Life Insurance Tax Calculator version information, visit our website. 

Within Microsoft Dynamics GP verify the version for Life Insurance Tax Calculator by selecting the Help Button, 

select About Microsoft Dynamics GP and then select the Options button. Click OK until the Life Insurance Tax 

Calculator window appears. 

http://www.integrity-data.com/hrp/product-releases/


 

P a g e  17 | 35 

 

Security Settings  
The Security Task Setup window may be used to grant or restrict access to the Life Insurance Tax Calculator 

windows. To open the window, select the Microsoft Dynamics GP menu, select Tools, select Setup, select 

System, select Security Tasks and enter the system password. 

1. Select the appropriate Task items. To identify the appropriate task item complete the steps below: 

• Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > User 

Security), select the appropriate user and make a note of the Security Role ID assigned to the 

user. 

• Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > Security 

Roles), select the Role ID that has been assigned to the user and make note of the Security 

Task ID assigned to the Role. Use this Task ID to grant security to the Life Insurance Tax 

Calculator. 

NOTE: The most common Task ID used is TRX_PAYRL_004 – Print Payroll Checks 

2. Select Life Insurance Tax Calculator for the Product. 

3. Select Windows for the Type and select 3rd Party for the Series. 

4. Use the Access List to grant or restrict access to individual items. 

 To grant or restrict access to an item for this Task ID, click the checkbox to mark or unmark 

the item. 

 Click the Mark All button to grant access to all items in the list or click the Unmark All button 

to restrict access to all items in the list. 

5. Click File > Print to print the Security Task Setup Report for the selected Task ID. 

6. Choose OK to save your changes. 

 

Life Insurance Tax Calculator > Windows > 3rd Party > Access 

List 

 APR Main Menu 

 Life Insurance IRS Table 

 Life Insurance Tax Code Setup  

 LIT Codes  
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Setup Windows 
Life Insurance Tax Code Setup  
To open the Life Insurance Tax Code Setup window, within the Navigation Pane select HR & Payroll, click Setup 

within the Content Pane, then under the heading Payroll, select Life Insurance Tax Calculator.  

The Life Insurance Tax Code Setup window allows the user to define the specific information used to calculate 

the taxable and exempt benefit amount and update the taxable and exempt benefit maintenance record.  

 

Microsoft Dynamics GP > Tools > Setup > Payroll > Life Insurance Tax Calculator 

 Select an existing LIT Code or create a new LIT Code. 

 Enter a Description of the Life Insurance Tax Code. 

 Specify the range of employees to be included in the Life Insurance Tax Calculation by using the 

following filter criteria. 

o Employee ID  
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o Department  

o Position  

o Employee Class 

o Employment Type 

 Company Premium Rate – Pay Period is the fixed premium per block of insurance.  

For example, $1.25 per bi-weekly pay period per $5,000 of insurance. The Company Premium Rate = 

$1.25. 

 Enter the amount for the Premium Increment for the life insurance plan.  

 The Factor is a multiple of the employee’s annual salary and used to calculate the total coverage 

amount.  

 The Factor Applies To Single, Variable or Both calculations when using Compensation Code for 

Coverage.  For example, if the total cost of coverage is 2 times the salary pay code plus the average of 

the last 6 months commission the Factor Applies To only the salary pay code.  In this example, select 

single thus the system would only apply the 2 times factor to the salary pay code.  If the system should 

apply the 2times factor to both the Salary and Commission then select both.  For more information on 

single verse variable calculations see Compensation Code Setup window. 

 The Pay Code for Coverage Calculation field is used to determine the compensation on which 

coverage is based.  

 The Payroll Frequency is used in the tax calculation to determine the cost of coverage per pay period.  

 Select the Pay Code for Coverage, for more information see Compensation Code Setup window. 

 Enter an Additional Amount to be applied to the total coverage amount.  For example, if the total 

coverage is 2times the salary plus $50,000 then enter the additional $50,000 in the additional 

amount field. 

 Benefit Excess Minimum is the amount of life insurance that is considered exempt from tax. Coverage 

amount above the Benefit Excess Minimum will be used to calculate the taxable premium.  

 The Taxable Benefit ID is the Life Insurance Benefit Code that is updated with the taxable benefit 

amount.  

 The Exempt Benefit ID is the Life Insurance Benefit Code that is updated with the exempt benefit 

amount. This field is used to calculate total cost of coverage. 

 When the user checks the Use Full Premium for Exempt Amount the system will break the premium 

down into taxable and exempt pieces as per the functionality of the calculator. However, the system 

will overwrite the normal exempt amount with the full premium amount.  

 If Human Resources is installed and registered the user has the option to determine the total coverage 

amount by marking the Use HR Premiums and Increments checkbox. 
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 If the Use Primary Pay Code for Coverage checkbox is marked the system will use the primary pay 

code to calculate the compensation on which coverage is based. 
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Compensation Code Setup window 
To open the Compensation Code Setup window, within the Navigation Pane select HR & Payroll, click Setup 

within the Content Pane, then under the heading Payroll, select Life Insurance Tax Calculator then from the 

GOTO on the Life Insurance Tax Calculator window select Compensation Code Setup.  

The Compensation Code Setup window allows you to setup multiple pay codes and calculations to calculate 

the total coverage amount for an employee.  For example, if the total coverage amount is 2 times the salary 

plus an average of the last 12 months commissions you would use a compensation code to calculate the total 

coverage amount. 

 

 Select an existing Compensation Code or create a new Compensation Code. 

 Enter a description for the Compensation Code. 

 Use Simple calculation for pay codes of type salary and hourly. 

 Enter the Pay Code for the Simple calculation.   

o For hourly, the system will use the rate of the pay code times the work hours per year times 

the percentage defined by the user.   

o For salary, the system will annualize the salary times the percentage defined by the user. 
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 Enter the percent to be multiplied by the annualized pay.  For example, if the 50% of an employee’s 

salary plus an average of the last 6 months commission will determine the amount to be factored for 

total coverage enter 50% in the percent field.  Then add the commission based on previous 6 months.  

The system will calculate the amount for both and sum them together.  On the Life Insurance Tax 

Calculator window if the factor applies to both the system will apply the factor to both the salary and 

commission calculation. 

 Use variable calculations for pay codes of type Commission, Piecework, Other, Charged Tips and 

Reported Tips.  The system will apply a calculation based upon the user defined Method, Calculation, 

Unit and Number. 

 Select the Pay Code to apply the calculation.  The calculation will be based upon the user defined 

Method Calculation, Unit and Number. 

 Select Average or Actual for the method.   

o For Average, the system will calculate the average amount based on either year to date or 

previous amounts based upon the users calculation selection. 

o For Actual, the system will determine the year to date compensation amount or previous days 

or months amount based on user defined unit and number fields.  

 Select YTD or Previous for the Calculation 

o For YTD, the system will determine the year based on the current user date.  It will look at 

payroll history and current pay run (if auto update is selected and calculate Life Insurance Tax 

Calculator is being run during build) for the year to determine an average or actual amount 

based method. 

o For Previous, the system will look at the previous months or days based on the unit and 

number selected. 

 Select Month or Days for the Unit. 

o For Month, the system will look at the specified months based on the number selected. 

o For Days, the system will look at the specified days based on the number selected. 

 Enter the Number of Months or Days the calculation will use to determine the average or actual 

amounts. 
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Life Insurance IRS Table 
To open the Life Insurance IRS Table window, within the Navigation Pane select HR & Payroll, click Setup 

within the Content Pane, then under the heading Payroll, select Life Insurance IRS Table.  

The user will have the ability to configure the premium rate and corresponding age range in the Life Insurance 

IRS Table. For the current IRS taxable rates go to the IRS Document Publication 15b and select p15b.pdf.  

 

Microsoft Dynamics GP > Tools > Setup > Payroll > Life Insurance IRS Table 

http://www.irs.gov/pub/irs-pdf/
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Scenarios 
Scenario 1: Using HR integration with a salaried employee 

Setup:  

 Use HR Premiums and Increments is marked 

 Use Primary Pay Code for Coverage is marked 

HR Life Insurance Setup has a Life Insurance Code called LIFENT with a Factor of 2 and a Fixed Premium of 

$1.25 per pay period per $5,000. LIFETX has already been set up as a code for the taxable portion of the life 

insurance costs. 

 

Solution:  

Adam Barr is 39 years old and is an employee at Fabrikam, Inc. His salary is $75,000 per year and he is paid 

biweekly. As part of the benefit package he receives group term life insurance coverage. The Life Insurance 

Calculator process handles the tax implications according to the following: 

 The annual wage must be determined; which in this case is $75,000 per year. This information is 

gathered from the primary pay code for the employee. 

 Coverage for the year must be determined. The LIFENT HR setup record shows factor of 2.0. Thus the 

coverage amount is set to $150,000 in the LIFENT HR Enrollment Record. 
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 Microsoft Dynamics GP will calculate the premium amount according to HR functionality. The result is 

$37.50 per pay period. This is the total cost of the premium per pay period. 

 The system must split $37.50 into taxable and exempt. 

o The taxable portion is calculated by taking the coverage amount and subtracting the Benefit 

Excess Minimum on the Life Insurance Tax Code Setup window. In this case the coverage is 

$150,000 per year minus $50,000 Benefit Excess Minimum. This reflects the normal $50,000 

exempt amount allowed by the IRS but could change and is thus configurable on the setup 

window. Now the system will take the remaining $100,000 and multiply by the rate we find 

on the schedule for a 39 year old in the Life Insurance IRS Table window (.09). Then divide by 

1,000 (as per IRS rules) this yields a result of $9 which is the taxable monthly cost of coverage 

according to the IRS. It is expressed in terms of months but we have a biweekly pay period 

specified in the Life Insurance Tax Code Setup window (Payroll Frequency field). Converting 

this monthly to biweekly means $9 multiple by 12 and then dividing by 26. This yields $4.15. 

So the taxable portion of our $37.50 premium per pay period is $4.15. 

o The exempt amount will be $33.35. 

 The system update the payroll benefit maintenance records for the LIFETX to reflect a $4.15 amount 

in premium and the LIFENT to reflect a $33.35 amount in the premium.  
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Scenario 2: Example of an hourly employee with no HR integration 
Setup:  

 Use HR Premiums & Increments is not marked 

 Use Primary Pay Code for Coverage is not marked. 

A Life Insurance record exists for LIFENT designated for the exempt portion. LIFETX has already been set up as 

a code for the taxable portion of the life insurance costs.  

 

Solution:  

Adam Barr is 65 years old and splits his time evenly between sales and technical writing. His primary pay code 

is sales but he earns a rate of $45.15 per hour for technical writing. He is still paid biweekly. As part of the 

original benefit package he receives group term life insurance coverage based on his work as a technical 

writer. The Life Insurance Calculator process handles the tax implications according to the following: 

 The annual wage must be determined. The system takes the technical writer hourly wage of $45.15 

and multiplies it by 2080 to annualize the wage. This results in $93,912 per year. 

 Coverage amount requires three key pieces of information specified on the Life Insurance Tax Code 

Setup window. 

o Company Premium Rate – Pay Period = 1.00 

o Premium Increment = $5,000 
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o Factor = 3 

 The salary is multiplied by a factor of 3 to arrive at the Coverage amount of $281,736. Since 

increments are set at $5,000 the adjusted coverage amount is rounded to the next highest increment 

$285,000. 

 From here, Microsoft Dynamics GP will calculate the premium per pay period (cost to employer) by 

taking the $285,000 dividing by the increment $5,000 and multiplying by the company premium rate 

of 1.0 the result is $57 per pay period. This is the total cost of the premium per pay period.  

 The system must split the $57 into taxable and exempt.  

o The taxable portion is calculated by taking the coverage amount and subtracting the Benefit 

Excess Minimum on the Life Insurance Tax Code Setup window. In this case the coverage is 

$285,000 per year minus $50,000 Benefit Excess Minimum. Now the system will take the 

remaining $235,000 and multiply by the rate we find on the schedule for a 65 year old in the 

Life Insurance IRS Table window (1.27). Then divide by 1,000 (as per IRS rules) this yields a 

result of $298.45 which is the taxable monthly cost of coverage according to the IRS. It is 

expressed in terms of months but we have a biweekly pay period specified in the Life 

Insurance Tax Code Setup window (Payroll Frequency field).To convert the monthly premium 

to biweekly we multiply $298.45 by 12 resulting in $3,581.40 then divide by 26. This yields 

$137.75. So the taxable portion of our $57 premium per pay period is $137.75.  

o This leaves a negative ($-80.75) as the exempt amount. Indeed Adam is being taxed on an 

amount which exceeds the total premium. This is a possible result given IRS rates increase 

dramatically after age 65.  

 The system updates the payroll benefit maintenance records for the LIFETX to reflect a $137.75 

amount in premium and the LIFENT to reflect a $-80.75 amount in the premium.  
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Scenario 3: Example of a salaried employee with no HR integration 

Setup: 

 Use HR Premiums & Increments is not marked 

 Use Primary Pay Code for Coverage is not marked. 

A Life Insurance record exists for LIFENT designated for the exempt portion. LIFETX has already been set up as 

a code for the taxable portion of the life insurance costs.  

 

Solution:  

Adam Barr is 34 years old and is a salaried web designer making $47,500 semiannually with a weekly pay 

period. The Benefit package does include a lot of life insurance coverage however, with a factor of 4 times the 

annual salary. Increments are set to $5,000 and the premium rate per pay period is $.50. The Life Insurance 

Calculator process handles the tax implications according to the following: 

 First the salary rate must be annualized which the system calculates at $95,000.  

 Then multiplying it by 4 yields the annual coverage of $380,000 in life insurance. From here the 

system must determine what the cost to the employer is per pay period for this coverage. 

 Since increments are set at $5,000 the per pay period cost of coverage amount is defined as $380,000 

divided by $5,000 multiplied by the Company Premium Rate – Pay Period ($.50) to arrive at $38. This 

is the total cost of the premium per pay period.  
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 Now the system must split the $38 into taxable and exempt amounts. The taxable portion is 

calculated by taking the coverage amount and subtracting the Benefit Excess Minimum on the Life 

Insurance Tax Code Setup window. In this case the coverage is $380,000 per year minus $50,000 

benefit excess minimum. Now the system will take the remaining $330,000 and multiply by the rate 

we find on the schedule for a 34 year old in the Life Insurance IRS Table window (.08). Then divide by 

1,000 (as per IRS rules) this yields a result of $26.40 which is the taxable monthly cost of coverage 

according to the IRS. It is expressed in terms of months but we have a weekly pay period specified in 

the Life Insurance Tax Code Setup window (Payroll Frequency field). Converting this monthly to 

biweekly means multiply by 12 and dividing by 52. This yields $6.09. So the taxable portion of our 

$26.40 premium per pay period is $6.09. 

 The remainder is $20.31 as the exempt amount.  

 The system updates the payroll benefit maintenance records for the LIFETX to reflect a $20.31 

amount in premium and the LIFENT to reflect a $6.09 amount in the premium. 
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Hints, Essentials and FAQs 
1. If the user wants the system to account for changes in employee salary or age automatically during 

the payroll process then mark the Auto Update checkbox for the LIT Code on the Life Insurance Tax 

Code Setup window. 

2. If the user wants to manually account for changes in employee salary or age then unmark the Auto 

Update checkbox for the LIT Code on the Life Insurance Tax Code Setup window. 

3. When the user marks the Use Full Premium for Exempt Amount the system will break the premium 

down into taxable and exempt pieces as per the functionality of the calculator. However, the system 

will set the exempt amount to the full premium amount. When using this option it is advisable for the 

user to set up posting account setup such that the benefit expense and benefit payable accounts are 

set to post to the same account for the taxable portion of the premium. This will ensure that accounts 

are kept in balance.  

4. Since the IRS dictates imputed income based on coverage amount irrespective of actual cost of 

coverage; it is possible that the system will calculate a negative amount for exempt portion when the 

taxable benefit (calculated by IRS) exceeds total benefit cost.  

5. A user may have Microsoft Dynamics GP HR installed but still choose not to integrate with it for 

purposes of the Life Insurance Tax Calculator. In these cases a user can still make use of the Use 

Primary Pay Code for Coverage check box even though the Use HR Premium & Increments checkbox is 

unchecked. The system will still find the primary pay code and, although HR functionality will not be 

used to calculate the premium, the system will use the specified values in Life Insurance Tax Code 

Setup window instead. 

6. The Exempt Benefit will be used to calculate total cost of coverage.  
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Activation Manager Messages 
Activation Failed: Trial invalid or trial period expired 
Situation: The trial period has expired for the product.  

Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.  

Activation Failed: Site name does not match this installation 
Situation: The site name does not match the token which was issued. 

Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error 

message displayed so the token can be updated with the correct site name. 

Activation Failed: Product Name does not match this installation 
Situation: The product name does not match the token which was issued for a product. 

Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error 

message displayed so the token can be updated with the correct site name. 

Trial period for Negative Payroll Transactions has expired 
Situation: The trial period has expired for the product. 

Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product. 

Employees Allowed has been exceeded 
Situation: The current employee count has exceeded the employees allowed. 

Solution: Contact sales@integrity-data.com to upgrade to the next tier. 

Activation Failed: Unable to contact web service. Activate manually or revert to previous 

product dictionary 
Situation: The system could not make a connection to the web service. 

Solution: Contact support@integrity-data.com for assistance. 

Activation Failed: Product has been deactivated 
Situation: The product has been deactivated. 

Solution: Contact support@integrity-data.com for assistance. 

Upgrade Failed: Enhancement Plan period expired. Renew Enhancement Plan or revert to 

previous product version. 
Situation: User attempted to upgrade a product when their enhancement plan was expired. 

Solution: Contact sales@integrity-data.com to renew the enhancement plan. 
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Life Insurance Tax Calculator Messages  
Message: One or more benefit codes specified lacks a setup record.  You must create a setup 

record for each benefit.  
Situation: User attempted to specify a benefit code which did not exist in the system. 

Solution: Select a new benefit code or create the desired benefit code from benefit setup.  

Message: One or more Taxable or Exempt Benefit ID Codes are not currently defined in GP 

Human Resources.  The update process cannot continue  
Situation: User attempted to use premiums and increments from HR when the benefits to be updated do not 

exist in HR. 

Solution: Setup the benefit within HR. 

Message: One or more employees have no primary pay code defined.  If you continue, benefit 

records for those employees will not be updated. 
Situation: User attempted to use primary Pay Codes for a calculation when one or more primary pay codes 

were not defined. 

Solution: Setup the primary pay code and assign to the employee or unmark the user primary pay code option.  

Message: One or more employees have no birth date defined.  The update process cannot 

continue 
Situation: User attempted to run an update for employee(s) who had no birth date defined. 

Solution: Open the employee maintenance record and define the employee’s birth date.  

Message: Pay Code for Coverage Calculation must be of type hourly or salary 
Situation: User attempted to enter a pay code of a type other than hourly or salary 

Solution: Select a pay code of type hourly or salary.  

Message: The Non-Taxable Benefit code is not set to Employer Pays “Full Amount” in Life 

Insurance setup.  Total benefit cost may be overstated 
Situation: User attempted to save a setup record or run the update process when the Taxable Benefit Code 

was set to a code where “Full Amount” was not specified for Employer Pays option in Life Insurance Setup. 

Solution: Set the taxable benefit code to full amount from the Life Insurance Setup window or select a 

different taxable benefit code.  
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Deactivate Product 
There are three ways to deactivate the Life Insurance Tax Calculator; disable, inactive or uninstall. 

Disable 

To disable Life Insurance Tax Calculator without having to exit Microsoft Dynamics GP, open the 

Customization Status window. To open this window, select the Microsoft Dynamics GP menu, point to Tools, 

select Customize and then click Customization Status. Select the product from the list and click Disable. The 

product can be enabled by closing and reopening Microsoft Dynamics GP. 

Inactivate 

Life Insurance Tax Calculator can be inactivated by company, open the Activation Manager window and 

unmark the company checkbox. 

Uninstall 

If Life Insurance Tax Calculator needs to be uninstalled complete these steps on the server and the client 

where Life Insurance Tax Calculator has been installed. 

1. Remove the GTLI6833.DIC file from the Runtime Directory 

Default location is C:\Program Files\Microsoft Dynamics\GP 

2. Make a copy of the Dynamics.set file 

3. Open the Dynamics.set file 

a. Decrease the top number by one: 

For example, if the top number is 21 change it to 20 

b. Remove the following lines from the Dynamics.set file: 

6833 

Life Insurance Tax Calculator 

:C:Program Files/Microsoft Dynamics/GP/GTLI6833.DIC 

:C:Program Files/Microsoft Dynamics/GP/Data/ GTLI6833F.DIC 

:C:Program Files/Microsoft Dynamics/GP/Data/ GTLI6833R.DIC 

4. Save the Dynamics.set file 

5. Launch Microsoft Dynamics GP and login as the ‘system administrator’ 

Uninstall Activation Manager 
Activation Manager will manage activation for all Integrity Data Products.  If you are uninstalling all Integrity 

Data products, you need to remove the Activation components. 

IMPORTANT: If you uninstall one product but have other Integrity Data products do not uninstall the 

Activation Manager components. 

1. Make a copy of the Dynamics.set file  

2. Open the Dynamics.set file 
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a. Decrease the top number by one: 

For example, if the top number is 21 change it to 20 

b. Remove the following lines from the Dynamics.set file: 

 

6537 

Integrity Data Activation 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/IDA6537.DIC 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537F.DIC 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537R.DIC 

1. Save the Dynamics.set file 

Make a copy of the Dynamics.exe.config file.   

3. Edit Dynamics.exe.config and find the line(s) beginning with: 
 

<addin name=”IDKeyManagerAddin” 

 

4. Remove the lines from both the <Dynamics> and <DynamicsGPWeb> sections. 
 

5. Save the Dynamics.exe.config file 
 

6. Launch Microsoft Dynamics GP and login as the ‘system administrator’ 
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Contact Information 
Get quick answers to your questions 

Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For additional 

questions, please contact your authorized Value Added Reseller (VAR) for support on this product (if you have 

one) or contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162. 

If you have registered your product, Technical Customer Service is available for any customers with a current 

Enhancement Plan or subscription. Please have your Company or Site Name available. Your first line of support 

should always be your VAR (if you have one). 

Join our User Groups 

We have an HR and payroll focused one and an ACA one – email lbelley@integrity-data.com to join! 

Rate us and our products 

Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Fill out the 

form on our contact page and leave your quote in the comment section. 

Suggest new features or improvements 

User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our 

Product Manager, at tfranz@integrity-data.com. As always, technical ideas and user input are highly 

encouraged. At Integrity Data, we want to hear your input, so drop us a line! 

Browse our solutions 

The Integrity Data website is a great place to get additional information on products and services. The 

following information is available on our website: 

 Integrity Data’s HR & Payroll software pages include Demos, Features and Benefits, and ROI 

Calculators 

 Visit our Services page to learn more about our additional customization services 

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail 

sales@integrity-data.com. 
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